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1 Warning and Disclaimer 

 

Danger 

Thank you for purchasing this ZERO UAV product. The product is an advanced and specifically 

dedicated control item.  Any misuse may result in damage to property, injury or even death. The user 

must conform to the law and use the equipment responsibly. This product is not suitable for people under 

the age of 18. Please read this disclaimer carefully before using the product, or visit the X4V2 web page 

at http://www.zerouav.com to refer to relevant updates or information. 

 

Caution 

1. Please keep the product out of reach of children. 

2. Make sure the aircraft is kept away from people and dangers such as buildings roads and property.  

We suggest you fly your aircraft at specially designated areas. 

3. Please do NOT fly this product when affected by drunkenness, tiredness, drugs, dizziness fatigue, 

nausea or any other condition that might impair your ability to control the aircraft.  

4. Please strictly follow the user manual when operating the device.  

5. Please make sure all components of the device are connected and work well, otherwise your unit 

may be damaged, destroyed or even buried! 

6. Please power off and remove propellers before making any adjustments to the unit such as 

calibrating, upgrading firmware or changing parameters. There is an ever present danger of the 

propellers starting unexpectedly and causing injury.  

7. Please do NOT fly in unfavorable conditions. 

8. Please do NOT open or modify the autopilot, there are no user serviceable parts inside. 

Disclaimer 

1. Zero UAV (Beijing) Intelligence Technology Co. Ltd. products are specially controlled devices. 

The user shall be responsible for any and all activities connected with the use of all their 

products. The manufacturer shall not be reliable for any consequences directly or 

indirectly caused by all their products.  

2. The user is responsible for abiding with the law and not behaving contrary to public order 

or public safety by using this product.  

3. We shall not provide technical support or security warranty for any of the following 

conditions:  

http://www.zerouav.com/
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1) Units or individuals obtaining the product from agents or channels not authorized by 

Zero UAV (Beijing) Intelligence Technology Co. Ltd.   

2) Products after modification, debugging or replacing parts without authorization;  

3) Products losing warranty card, serial number or flight data;  

4) Injuries and property losses due to mis-operation or force majeure of natural 

disasters.   
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2 Terms and Abbreviations 

Name Description 

GCS Ground control station  

SSID Service Set Identifier, name of wireless network 

Dual controller operation  
Aircraft radio control transmitter +Gimbal radio control 

transmitter 

Single controller operation  
To control the aircraft and gimbal with a single radio control 

(RC) transmitter  

CH 
Channel, for example CH5 means channel 5 

Channel switches assigned to different functions  

F/S  Fail/Safe control  
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3 Functions  

The types and related functions of the aircraft are as follows:  

 Airframe type: 4-axis X-type, 4-axis cross type, 6-axis X-type, 6-axis cross type, 8-axis 

X-type, 8-axis cross type, 6-axis reverse Y-type, 6-axis Y-type, 4-axis X-type with 8 motors 

and customized types (irregular or quasi-irregular);  

 Firmware upgrading: PC upgrading (standard USB serial port cable);  

 Control mode: transmitter radio control/mobile control;  

 Parameter adjustment mode: PC/tablet PC/mobile ground station ;  

 Operation mode: manual stabilization, automatic hover, automatic navigation and return 

and land;  

 Status indication: LED  

 Security measures: auto return on loss of control, black box flight recorder; 

 PTZ: servo PTZ;  

 Receiver: Standard receiver, S-BUS receiver, PPM receiver 
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4 In the Box 

                                               Key:  ■Hardware □Software (download） 

■Controller X1 ■GPS+COMPASS （hereinafter referred 

to as GPS）X1 

 

The MC (Master Controller) combines and 

communicates with the other modules and external 

electronic devices to carry out its function as a 

complete autopilot system. Firmware is updated in 

this unit via its RS232 COM port. The YS-GCS 

(Ground control Station) records real time flight state 

via WI-FI. 

 

The GPS/Compass modules are for sensing 

the orientation of the aircraft by reading its 

position and direction. 

■External LED indicator X1 ■Power module X1 

 

The LED indicates current flight status of the craft. 

The light shows information such as flight mode, 

number of satellites in view and battery used. 

 

Supplies regulated power for the autopilot and 

the Wi-Fi module. 

■WIFI module X1 ■R232 serial port to USB converter cable 

(FTDI) X1 

 

Connects the Auto Pilot to the Ground Station via 

WI-FI (Wireless Network) Supports 2 work modes: 

Peer to Peer and Router 

 

 

Connects PC and autopilot via USB to 

update firmware. 

■GPS bracket X1 ■Warranty card X1 

The GPS ＋ COMPASS is sensitive to magnetic 

interference. This bracket is used to mount the GPS 

module where necessary and to keep it far away 

from EMI sources. 

This provides Product Serial No., Purchase 

Date. Please fill out the relevant information 

and return to Zero UAV Intelligence 

Technology Co. to register your product 

warranty. 

□Ground station software     □Upgrade software  
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5 Installation 

5.1 Airframe Types 

The X4V2 flight controller provides support for aircraft in a cross (+), X and Y configurations of 

rotor arms and propellers. 

In the figures below, the yellow arrow at the position of the central plate indicates the direction 

of the aircraft nose; the blue curved arrow indicates the direction of rotation of the upper 

propeller and the purple curved arrow the direction of rotation of the lower propeller.  

NB 

Install the motor and propellers according to the following modes. 

                  

Quad-Rotor +4              Quad-Rotor x4               Hexa-Rotor +6 

                  

Hexa-Rotor x6               Octo-Rotor +8               Octo-Rotor x8 

                

Hex-Rotor reverse Y6             Hex-Rotor Y6                Quad-Rotor X8 
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5.2 Installation of Flight Controller  

Install the X4V2 flight controller on the central deck of the aircraft horizontally, with the arrow 

labelled “Front” pointing to the aircraft nose, as indicated in the following diagrams:  

Direction of

aircraft nose

 

 

5.3 Installation of the GPS  

Install the GPS on the bracket with the GPS 

label facing upwards and the small arrow 

pointing to the aircraft nose.  

 

The appearance of the bracket is as shown in 

Figure 1. 

 
Figure 1 

 

NB 

 Make sure the small arrow points to the aircraft nose. If not the aircraft will circle (toilet 

bowl) when in auto-hover;  

 Place the GPS module in an elevated and horizontal position, away from equipment 

which can produce magnetic fields such as cables, transmitters and cameras without 

screening. 
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6 Wiring  

6.1 Port Definitions 

Port Definitions: X4V2 flight controller 

Port Port function Port Port function 

M1 ESC for Motor #1  AIL Aileron 

M2 ESC for Motor #2 ELE Elevator 

M3 ESC for Motor #3 THR Throttle 

M4 ESC for Motor #4 RUD Rudder 

M5 ESC for Motor #5 CH5 Switching flight mode 

M6 ESC for Motor #6 CH6 Switching flight mode 

Y1 Connect NO.7 ESC or connect roll 

of servo gimbal for multiplex CH7 

Control the gimbal pitch and roll 

Connect S-BUS receiver for multiplex 

( NOT support S-BUS2 port of 7008SB) 

Y2 Connect NO.8 ESC or connect 

pitch of servo gimbal for 

multiplex 

CH8 Connect PPM receiver for multiplex 

COM 
Wi-Fi data unit or to PC via USB 

for updating firmware etc.  
AI1 Power management module (option) 

LED LED indicator  POW 5.7V output from power module  

  
GPS-R 

GPS-B 

GPS-R: Red terminal from GPS module  

GPS-B: Black terminal from GPS 

module  

 

6.2 Wiring Diagram 

Notes: 

a. The power supply range for the power module and Wi-Fi module should be a Lipo battery 

of between 3S and 6S, namely 10.8v-25.5v;  

b. The RC receiver should be powered directly from the flight controller. If an external power 

supply is used at the same time the equipment may be destroyed. 

c. The ESCs and motors can cause serious magnetic interference. The GPS and magnetic 

sensor modules must be installed as far away as possible from motors and ESCs 

(particularly where there are multiple ESCs). The arrow on the GPS must be pointed at 

the aircraft nose. The power lead from the battery will create a large magnetic field 

particularly when large currents are drawn. Keep this as far away as possible from the 

GPS module to avoid flight artefacts such as “toilet bowling”. 
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d. A servo driven gimbal should not be powered from the receiver but should be powered 

separately. 

e. The video transmitter (VTX) must be kept as far away from the aircraft electronics as 

possible to avoid serious interference. 

f. Make sure the full system power is not connected directly to the flight controller. This will 

destroy the flight controller which should be powered by a 5.7 V output only. The LED 

indicator will flash three times after the initialization of the flight controller, indicating that 

correct correction has been made and the system started normally.  

Wiring diagram 

Electronic Speed 
Controllers

（M1-M8）

Main Controllers(X4V2 )

· The main controllers are horizontally mounted  in the centre of the aircraft 

with the arrows marked “front” pointing forward. The controllers may 
be mounted direct without damping.

· Ensure that all terminals of the flight controllers are uncovered; this 
facilitates the wiring and makes it easier to connect to a PC for firmware 
upgrade. 

· Finalize the position of all flight control components and complete the 
wiring before finally fixing them in position.

RC Receiver

· First set up the aileron, 
elevator, throttle and 
rudder on the remote 
controller(RC transmitter). 

· The receiver (support S-
BUS and PPM receiver) is 
powered by the 
controller ; an external 
power supply is not 
needed.

· Connect the receiver to 
the corresponding 
channels on main board.LED Indicator

· Install the LED in 
a convenient 
position, away 
from the GPS 

GPS Module

· The GPS and magnetic compass 
module is magnetically sensitive 
equipment, which should be 
kept away from other electronic 
equipment.

· Use the original GPS housing to 
install the GPS module.

· The GPS is also sensitive to 
shaking. Please secure the frame 
of the GPS firmly and install with 
the logo facing upwards and the 
arrow facing farwards.

3S-6S Lipo
WiFi

com3

+
Power

-

LED

Power Unit Option

expansion 
interface

Servo Driven 

Gimbal

5.7V

RC Receiver

1
2
3
4
5
6
7
8

S-BUS Receiver

PC or OSD

PPM Receiver

Power 
Supply Unit

 



 

10 System Preparation and Debugging | Zero UAV (Beijing) Intelligence Technology Co., Ltd. 

 

 

7 System Preparation and Debugging  

The X4V2 Aircraft system links to PC or Android ground station software. As the Android is 

more convenient for debugging and flight monitoring at the field, this is the recommended 

system.  

7.1 GCS Installation 

7.1.1 Installation of Mobile GCS  

Android mobile GCS should be installed as follows:  

1. Download YS-GCS Android mobile software from the download section in the support 

zone of the official website (www.zerouav.com). 

2. Automatically install the software by clicking on the APK file in the 

file manager. The ground station App will appear on the mobile 

device desktop after installation as shown in Figure 2. The GCS 

must be installed in the memory of the mobile.   
Figure 2 

7.1.2 Installation of PC GCS  

Download the YS-GCS PC software from the download section in the support zone of the 

official website (www.zerouav.com). After decompressing, double-click the ZERO-GCS Rotor 

Ground Station.exe file to install the program.  

7.2 Wi-Fi Configuration  

7.2.1 Wi-Fi Communication Mode  

The X4V2 Wi-Fi system can support two communication modes: point-to-point (P2P) and 

router. The delivery default setting is point-to-point mode with an SSID of ZERO-TECH and no 

password.  

After the link is completed all flight data will be recorded to the ground station. The file with the 

extension of “.hj” can be found in the directory “YShj” in the root directory of a mobile device or 

in the file folder “Hj” in the PC ground station software package. This file can be replayed and 

analyzed in the PC GCS application.  

A Wi-Fi configuration tutorial can be found at: 

http://v.youku.com/v_show/id_XNTE2OTY4MjQ4.html 

7.2.2 Wi-Fi Configuration  

7.2.2.1 Firmware Connection 

The firmware can be updated using the following procedure:  

http://www.zerouav.com/
http://www.zerouav.com/
http://v.youku.com/v_show/id_XNTE2OTY4MjQ4.html
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1. Download the USB driver from the ZERO 

official website and install it;  

2. Connect the Wi-Fi module to a PC with the 

supplied USB serial port cable shown below. 

Connect the USB terminal to any USB port 

on the PC and the serial terminal to the com 

port of the Wi-Fi module;  

3. Plug the lead reserved for the Wi-Fi module 

from the power supply into the Power port of 

(3S-6S input) of the Wi-Fi module.  

       WiFi

com3

+
Power

-

 

Note: 

 When connecting the Wi-Fi module to the Computer, the WHITE wire of the 

communication cable is located at the upper right hand corner of the Wi-Fi module. 

 When connecting the Wi-Fi module to the X4V2, the BLACK wire of the communication 

cable is located at the upper right hand corner of the Wi-Fi module.   

WiFi

com3

+
Power

-

WiFi

com3

+
Power

-

Connect with PC Connect with 
the flight 
controller

 

 

7.2.2.2 Software Set-up 

7.2.2.2.1 Point-to-point Mode 

It is possible to use the wireless router in the point-to-point mode and the password can be set 

up in this mode to make sure no other user can connect to the Wi-Fi. Setup procedure is as 

follows: 

1. Download Wi-Fi configuration software from 

the Zero UAV site. 

2. Double-click “SeanyConfig.exe” after 

decompression and a “SeanyConfig” 

window will pop up, as shown in Figure 3. 

3. Click “Setting” for the main interface, as 

shown in Figure 4.  
Figure 3 
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Figure 4 

4. Select the correct COM port. If you are unsure which port this is you can search for the 

“Prolific USB-to-Serial Comm Port” in your Windows Device Manager. This will give you 

the port number. Check "AP" (Access Point) which is "PTP mode". 

To check your port: right-click “My computer”→“Properties”→“Device manager”→“Port 

(Com and LPT), as indicated in Figure 5.  

 
Figure 5 

5. Set up the SSID of Wi-Fi module, 

default is “ZERO-TECH”. 

6. Uncheck “No Passphrase”; the Wi-Fi 

password must be five digits; as 

shown in Figure 6. 

7. Click “Apply” and wait for completion 

of the software configuration; click 

“Yes” to exit after the window “Ap 

mode OK” pops up, as shown in Figure 

7. 

8. Connect your mobile device or PC 

GCS to the SSID via wireless after set 

up. 

9. The Wi-Fi blue indicator changes from 

solid to flashing to indicate the GCS is 

connected and receiving data. 

 
Figure 6 

 
Figure 7 

7.2.2.2.2 Router Mode  

Set up Wi-Fi router mode if your mobile device or PC is incompatible with P2P.  
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Configuration of router mode is similar to that of point-to-point mode and you should proceed 

as follows:  

1. Download Wi-Fi configuration software 

from the ZERO official website to your 

PC;  

2. Double-click “SeanyConfig.exe” after 

decompression and a “SeanyConfig” 

window will pop up, as shown in Figure 8. 

3. Click “Setting” and the main interface will 

pop up, as shown in Figure 9. 

4. Select the correct port and check “Infra 

station”, as shown in Figure 10. 

5. Set up the SSID of Wi-Fi module, default 

is “ZERO-TECH” it is case-sensitive and 

the default password is 82890430. 

6. Complete the configuration modification 

by clicking “Apply”. 

7. A video showing how to configure the 

route can be seen at: 

http://v.youku.com/v_show/id_XNTE3Nz

E1NDcy.html/;  

8. Connect your mobile device or PC GCS 

to the SSID via wireless after set up. 

9. The Wi-Fi blue indicator changes from 

flashing to solid to indicate the GCS is 

connected and receiving data. 

 
Figure 8 

 
Figure 9 

 
Figure 10 

Note:  

 The SSID and password of the router must be consistent with those of the Wi-Fi module;  

 TP-LINK is taken as an example for the router configuration in the video;  

 WPA2-PSK AES encryption method is used with an IP of 192.168.1.1. 

7.3 Setting up the Transmitter(s)  

Fixed wing mode must be used in the RC transmitter without any mixes configured. If you are 

using FUTABA none of the channels should be reversed. All channels should be reversed for a 

JR or WFLY transmitter. 

http://v.youku.com/v_show/id_XNTE3NzE1NDcy.html/
http://v.youku.com/v_show/id_XNTE3NzE1NDcy.html/
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The transmitter of the aircraft can be set up as follows:  

1. Set three-position switches to CH5 and CH6 on the transmitter as indicated in the 

following diagram:  

 

2. To set up F/S (Fail safe) protection set both CH5 and CH6 of the transmitter to Position 3 

and the accelerator near central position (50%). 

The relationship of four operation modes is indicated in the following table:  

CH5 status CH6 status Operation mode 

Position 1  X, (Any Position) 

Manual stabilisation 

If Channel 5 is switched to position1 then the aircraft 

will be in manual stability mode whatever the position 

of Channel 6  

Position 3  Position 1  Automatic hovering   

Position 3  Position 2  Automatic navigation  

Position 3  Position 3  Returning and landing  

Note: Position 2 of CH5 is a functional Position in which the Carefree mode can be selected. Refer 

to “10.2.8 Carefree Mode” for more information. 

 

Refer to your transmitter manual for specific instructions to set up failsafe and take a look at 

this video: http://www.tudou.com/programs/view/e1ai526Mbt4/.  

 

http://www.tudou.com/programs/view/e1ai526Mbt4/
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8 Ground Control Software setup and Debugging  

The aircraft will be set up by following the GCS installation guide. We can follow your own 

customized setup in the GCS app. It is recommended that you follow the GCS installation 

guide because it is easy to miss out essential steps if you do it yourself and you may damage 

the equipment as a result.  

You should pay attention to the following points during the installation:   

 Before turning on the transmitter or powering the flight controller when you are installing 

or debugging, make sure the propellers are removed, and it is recommended that you are 

able to power the motors separately from the controller.  

 Switch your transmitter to manual mode and advance the throttle before entering settings, 

otherwise it will not be possible to make changes.  

Note:  

 Carry out the following inspections if there is no data transmission during installation or 

debugging:  

1. Examine whether the wires are connected correctly;  

    2. Examine whether there is any problem with the flight controller; connect the flight 

controller to the PC and see whether there is any data transmission from the flight 

controller; the flight controller can be considered faulty if there is no data transmission 

but the USB serial port lead is working okay.  

3. Check Wi-Fi configuration;  

 An automatic alarm will be made by the mobile ground station if the voltage is too low.  

8.1 Mobile Ground Station Debugging  

8.1.1 Ground Station Software Auxiliary Setting (Installation Guideline) 

The ground station software auxiliary settings are as follows:  

1. Connect the ZERO-GCS app on your android mobile device or tablet to the autopilot by 

Wi-Fi to enter the initial interface screen, as shown in Figure 11. 

2. Click “Settings ” for the settings interface, as shown in Figure 12. 

3. Click “Installation Guide” to start the installation, as shown in Figure 13. 
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Figure 11 

 
Figure 12 

 
Figure 13 

4. Click “Next” to start setting up or debugging by following the on-screen instructions:  

              
Step 1                       Step 2                       Step 3 

              
Step 4                       Step 5                       Step 6  

5. Click “Next” to exit the installation guidelines. An instructional video can be found here:  

http://www.tudou.com/programs/view/h6Umvfs1my8/.  

http://www.tudou.com/programs/view/h6Umvfs1my8/


 

Zero UAV (Beijing) Intelligence Technology Co., Ltd. | Ground Control Software setup and 

Debugging 
17 

 

8.1.2 Manual Settings 

8.1.2.1 Transmitter Mode Set Up 

Powers to the motors should be off or propellers removed to guarantee safety. 

1. Select correct operational mode;  

a) Click menu on your android to open the dialogue, as shown in Figure 14. 

b) Click “Set” to open the setting window, as shown in Figure 15. 

c) Open the drop-down menu next to “Stick mode”, as shown in Figure 16. 

 
Figure 14 

 
Figure 15 

 
Figure 16 

d) Check next to your stick mode; for example “US” would be mode two (left-hand 

throttle). 

2. Verify correct stick movement. 

a) Press “Adjust Transmitter” in the settings interface, 

and then press “OK” to confirm. 

b) Within 5 seconds rotate the left and right transmitter 

sticks to their extremes in all directions, as shown 

in Figure 17. The flight controller will 

automatically collect maximum, minimum and 

neutral values for each channel. 

 
Figure 17 

3. Now make sure that the direction of movement of the sticks is reflected accurately in the 

diagram below. You can only proceed to the next step after confirming this.  

c) How to check stick position:  

– In the diagram below showing “Manual Servo Data” in the data interface, the left 

stick is rotor and elevator and the right is aileron and throttle, as shown in Figure 

18. 
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– When the sticks are in neutral position they will 

be shown as green. The vertical will be shown 

the yellow when fully extended and the sticks 

will be shown as red in any other position than 

neutral. 

d) It is necessary to select “capture transmitter central 

point” in the settings interface to make the flight 

controller record the correct neutral position of the 

sticks if, for example, if either stick is not in the 

central position after fine tuning.  

 
Figure 18 

8.1.2.2 Check CH5 and CH6 for F/S (fail/safe protection)  

 Check operation mode switching is correct: 

You need to check with mode switching is normal each 

time you connect the GCS. 

For example, looking at the data interface on the GCS, 

flight mode should display “Manual” when CH5 is at 

position 1 and CH6 is at any position, as shown in Figure 

19. This is not the case you should look at the data link 

or the settings in your transmitter. 

 Check F/S protection  

Turn off your transmitter, the flight mode should display 

“Returning to land” and the throttle should show is 

neutral (green). This is not the case you should reset 

F/S protection.   
Figure 19 

8.1.2.3 Setting up Aircraft Parameters 

The autopilot is set to 4-axis X-type 

mode as default before delivery and 

the parameters should be set up 

according to the following procedure: 

1. Click the “Parameter” tab for the 

parameter interface, as shown in 

Figure 20. 

2. Click “Get” to load the existing 

parameters of the aircraft;  

 
Figure 20 
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3. Click “Send” after any alterations to send the modified parameters to the aircraft;  

Please refer to the following table specific parameter descriptions:  

Note:  

 Click Get or Send multiple times to avoid failure in obtaining or sending parameters;  

 Click “Default” to recover factory setting values.  

Parameter name Setting description 

Roll Sensitivity 

Pitch Sensitivity 

This is the sensitivity of roll and pitch of the aircraft. The value will 

have a direct effect on the sensitivity of the controls, too small or 

too large settings will make the aircraft unstable.  

Settings represent the angle speed error and are in the range of 

0 to 255. The larger the value of the sensitivity, the more rapid 

the response of the aircraft, but too much sensitivity will result in 

high frequency vibration. Sensitivity needs to be reduced for 

aircraft with high-speed, smaller propellers. 

Sway Compensation This sets up vibration dampening for aircraft with a lower 

propeller rotation speed; this will improve the stability but reduce 

sensitivity. The range is from 0 to 255. A value too high or too low 

will cause instability. 

If there is no sway compensation, the aircraft will rock backwards 

and forwards rather than snapping directly into its neutral 

position. 

– If your aircraft repeatedly rocks, then the value needs to be 

increased to stop the aircraft rocking. 

– This value should be reduced when the high-speed vibration 

appeared. 

Photo spacing Sets up the distance interval (in meters) between two photograph 

captures within the range of 5m- 255m.  

This parameter is only available in automatic photography mode. 

PTZ Roll Sensitivity 

PTZ Pitch Sensitivity 

The PTZ (Gimbal) roll output and PTZ pitch output sensitivity is 

used to adjust the compensation angle of the PTZ data for your 

Gimbal.  

You can compensate high or low for aircraft movement within a 

range from -127 to 127. 

Note: You can enter a negative value to reverse the direction of 

compensation. 

Cell Num Enter the cell number of your flight battery (4S shown) 

The autopilot can calculate the low voltage alert according to the 

Cell Number filled in by the user. If your cellphone vibrates once 

every 2 seconds it is a reminder that the power is getting low. 

When it vibrates continuously it means the power is getting very 

low and you should land at once. 

Altitude Limit 

Distance Limit 

This shows the highest and furthest distance which the aircraft can fly.  

You can enter the value 0 for unlimited distance. You can also fill in your 

own distance limit value.  

Note: The aircraft will automatically return to the starting position 
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Parameter name Setting description 

if the height or distance limit is exceeded after taking off in 

manual or GPS mode. It is not possible to regain control of the 

aircraft until it is back within the permitted range.  

Volt Alert Threshold Enter the voltage per cell required to activate a low voltage alert, 

for a Lipo battery this would be normally 3.65v. 

PAR+PHO Multiplex 1. If using a brushless gimbal: select parachute-opening + 

photograph 

2. Servo Gimbal: select 2-axis PTZ  

Aircraft Type Set according to the type of aircraft in use.  

Handle Mode To select speed mode or status mode The speed mode is the 

speed in GPS mode while the status mode is the speed in 

manual mode. It’s necessary to fill in maximum flight speed when 

selecting status mode.  

Max Fly Speed Flight speed is governed to the value selected.  

 

4. Customized parameter setup (Users of common standard aircraft patterns may skip 

this bit)  If you are using a non-standard multirotor with an irregular flight configuration 

you may set up the parameters according to your own requirements, customizing the 

speed increase and decrease ratios of the roll, pitch and yaw channels of each axis. 

The specific definitions are as follows: 

Channel Aircraft activity Required parameter values 

Throttle Climb or descent 100 for all  

Yaw Rotate to the right  Decrease to -100 or increase to 100  

Pitching  Pitch down  Decrease to -100 or increase to 100 

Rolling  Roll to the right  Decrease to -100 or increase to 100 

 

Flight parameters can be set up using 4-axis X-type 

quadcopter as an example, as shown in Figure 21. 

Set up as follows:  

a) Click “Settings” in the GCS;  

b) Click “Mixing Define” for the parameter setting 

interface;  

c) Fill in the necessary parameters and click “Send” to 

send your modified values to the flight controller; 

click “Get” to download the parameters again from 

the GCS to check whether parameters are 

uploaded successfully. 
 

Figure 21 
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d) Click on the “parameter” interface and select “aircraft type” and select “user-define”;  

e) After successful modification of parameters, power up the aircraft, throttle up gently 

and carefully note that the aircraft response is consistent with your settings; now you 

can confirm this with a trial flight. 

NB 

Because the motors might immediately rotate at high speed after the aircraft type has been 

modified, it is strongly recommended to remove propellers to make sure of safety. 

 

8.1.2.4 ESC Stroke Calibration 

Please remove propellers before ESC stroke calibration.  

Some ESCs which have been designed specifically for multi-rotors do not need to be 

calibrated. Here we take the Hobbywing I did as yours ESC as example: hi DDM goodtime. 

1. Connect the autopilot power 

only, pull the throttle to the 

bottom and put CH5 to 

position 1. 

2. Click "Init Setup" in "Setting" 

page, as shown in Figure 22. 

Click "Confirm" button in the 

dialog box. Now the "Flight 

Mode" should be displaying 

as "Settings" in the Data 

screen of the GCS, as shown 

in Figure 23. 
 

Figure 22 
 

Figure 23 

3. After arming the motors with CSC (Section 9.2 Unlocking and Arming the Motors), push the throttle 

all the way to the top and then connect power on (No propellers!) 

4. Pull the throttle to its lowest position after two confirmatory sound signals from the ESCs 

and the gimbal controller will also sound a number of beeps to indicate the number of 

cells in the battery. This will complete ESC calibration.  

5. Click “Quit Setup” and confirm in the dialog box that pops up.  

6. To check whether verification is successful, push the throttle after unlocking and all my 

motors should work simultaneously.    
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8.1.2.5 Inspection of Flight Controller and GPS Installation  

The flight controller and GPS installation should be inspected as follows:  

1. Check that the arrows of X4V2 and GPS are all pointing to the aircraft nose.  

2. Check X4V2 is installed horizontally and GPS is elevated and installed horizontally;  

3. Check X4V2 and GPS are fixed firmly.  

 

8.2 PC Ground Station Setup and Debugging 

8.2.1 Ground Station Software Auxiliary Setting (Installation Guideline) 

The ground station software should be set up as follows:  

1. Connect the PC to the Wi-Fi 

module, or directly to the 

COM1 on the auto pilot 

using the USB adaptor, and 

run “ZERO-GCS rotor 

ground station.exe” to enter 

the initial interface, as 

shown in Figure 24.  
Figure 24 

2. Select “File”→ “Open Wi-Fi”, the flight data information bar will pop up at the bottom of 

the ground station window, indicating controller data, as shown in Figure 25. 

3. Now select “Settings”→“Installation guide”, to pop up the installation debugging window, 

as shown in Figure 26. 

 
Figure 25 

 
Figure 26 

4. Click “Next” for the installation operation stage. Complete the required information as 

indicated below:  
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Step 1 Set the aircraft type, battery cell number 

and required alarm voltage from a single cell. 

 

Step 2 Check channel settings, and failsafe 

setting (F/S) 

 

Step 3 Select transmitter Stick Mode and 

direction of stick movement. 

 

Step 4 Calibrate ESCs  

 

Step 5 Unlock (using the CSC operation) and 

check channel mixing.  

 

Step 6 Examination of flight controller and GPS 

installation  

5. Click “Finish” to exit the installation guide after software debugging.  
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8.2.2 Manual Settings  

8.2.2.1 Calibration of Transmitter  

The power supply should be disconnected from the motors or propellers removed before 

continuing. The transmitter is calibrated as follows:  

1. Select correct stick mode;  

a) Run “ZERO-GCS rotor ground 

station.exe” and open Wi-Fi;  

b) Select your TX stick mode from 

the pull-down menu, as shown 

in Figure 27. (Mode 2 – 

American standard is shown) 

 
Figure 27 

2. Calibrate Stick Movement 

a) Click “Setting(S)”→“Transmitter (T)”→“Adjust Transmitter (C)”, the calibration prompt 

dialogue will open, as shown in Figure 28 

b) Click “Yes”, within 5 seconds rotate the left and right transmitter sticks to their 

extremes in all directions, as shown in Figure 29. The flight controller automatically 

record the maximum and minimum values for each control axis and also the neutral 

values. 

 
Figure 28 

 
Figure 29 

3. Check the stick movement is consistent with the directions indicated in the GCS;  

a) Check display positions:  

– In the flight data interface, stick positions are shown as per the diagram below. 

Mode 2 is indicated where the throttle and rudder are on the left stick, the aileron 

and elevator are on the right stick, as shown in Figure 30. 
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– When the sticks are in their 

neutral position they are 

shown in green. When 

moving they are shown in 

red. At their full extent they 

are shown in yellow.  
 

Figure 30 

b) Select “Setting”→ “Transmitter”→“Capture Transmitter Centre point (N)”, to 

make sure the flight controller records the correct neutral position if this has not 

already been done in fine tuning. 

 

8.2.2.2 Checking CH5 and CH6 Switching and F/S (failsafe) 

 Check operation mode switching 

Check whether the switching of operation mode is correct after connecting GCS module.  

For example, the flight state 

on the “Flight status” 

interface on the right side of 

the GCS should display 

“Manual” when CH5 is at 

position 1 and CH6 in any 

position and so on, as shown 

in Figure 31. If not, examine 

the firmware connection or 

your transmitter settings.   
Figure 31 

 Check F/S protection 

Switch off your transmitter, flight state should display “Back landing” and the throttle slider 

should be near the neutral position in green in the “Manual servo” in the flight data 

interface. This is not the case recheck your failsafe setup. 

 

8.2.2.3 Setting up Aircraft Parameters 

The steps of setting up aircraft parameters are as follows: 

1. Select “Setting(S)”→“ Parameters (P)”, the parameter setting window will pop up, as 

shown in Figure 32. 

2. Click “Get” to obtain the existing parameters of the aircraft;  



 

26 
Ground Control Software setup and Debugging | Zero UAV (Beijing) Intelligence Technology 

Co., Ltd. 

 

3. Click “Send” after 

parameter adjustment 

to send the modified 

parameters to the 

aircraft. 

An explanation of 

parameters can be 

found in “8.1.2.3 

Setting up Aircraft 

Parameters”. 

 
Figure 32 

Note:  

 Click Get or Send multiple times to avoid failure in obtaining or sending parameters;  

 Click “Default” to recover factory setting values.  

4. Customized parameter setup (Users of common standard aircraft patterns may skip 

this bit)  If you are using a non-standard multirotor with an irregular flight configuration 

you may set up the parameters according to your own requirements, customizing the 

speed increase and decrease ratios of the roll, pitch and yaw channels of each axis.  

The specific definitions are as follows： 

Channel Aircraft activity Required parameter values 

Throttle Climb or descent 100 for all  

Yaw Rotate to the right  Decrease to -100 or increase to 100  

Pitching  Pitch down  Decrease to -100 or increase to 100 

Rolling  Roll to the right  Decrease to -100 or increase to 100 

 
An example of flight parameter set up is shown in Figure 33, using a 4-axis X-type quad 

copter as an example. 

Setting up procedure is as follows:  

a) Click “Setting ”→“Other (O) ”→“ Mixing 

Define (E)” in the GCS. 

b) Fill in required parameters and click 

“Send” to send these values to the flight 

controller; click “Get” to download latest 

parameters to the GCS to check 

whether parameters have been 

uploaded successfully. 
 

Figure 33 
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c) In the “Parameters(P)” dialogue enter your correct “Aircraft Type”, for example 

“Quad-Rotor Cross” 

d) Power the flight controller after confirming successful modification of parameters and 

apply a small amount of throttle to check the motors are spinning in the correct 

directions. If this is successful you are all set to make a trial flight.  

NB 

Because the motors might immediately rotate at high speed after the aircraft type has been 

modified, it is strongly recommended to remove propellers to make sure of safety. 

8.2.2.4 ESC Stroke Calibration 

Please remove propellers before ESC stroke calibration. 

Some ESCs which have been designed specifically for multi-rotors do not need to be 

calibrated. Here we take the Hobbywing ESC as an example. 

1. Connect the autopilot power 

only, pull the throttle to the 

bottom and put CH5 to 

position 1. 

2. Click "Init Setup" in 

"Setting" page. Click 

"Confirm" button in the 

dialog box. Now the "Flight 

Mode" should be displaying 

as "Settings" in the Data 

screen of the GCS, as 

shown in Figure 34. 

 
Figure 34 

3. After arming the motors with CSC (Section 9.2 Unlocking and Arming the Motors), push the 

throttle all the way to the top and then connect power on (No propellers!) 

4. Pull the throttle to its lowest position after two confirmatory sound signals from the ESCs 

and the gimbal controller will also sound a number of beeps to indicate the number of 

cells in the battery. This will complete ESC calibration.  

5. Click “Quit Setup” and confirm in the dialog box that pops up.  

6. To check whether verification is successful, push the throttle after unlocking and all 

motors should work simultaneously.  
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8.2.2.5 Examination of flight controller and GPS installation  

The flight controller and GPS installation should be inspected as follows:  

1. Check that the arrows of X4V2 and GPS are all pointing to the aircraft nose.  

2. Check X4V2 is installed horizontally and GPS is elevated and installed horizontally;  

3. Check X4V2 and GPS are fixed firmly. 
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9 Pre Flight Inspection 

9.1 Calibrating the Magnetic Compass 

9.1.1 Using the Android GCS 

NB 

 The magnetic compass must be calibrated before the first flight after installation of the 

X4V2 flight controller. 

 Calibration should be carried out in a clear space outside; calibration should not be done 

indoors or in an environment with strong magnetic fields, such as in the presence of cars 

or shipping containers.  

 You should also calibrate after re-arranging components in your aircraft or if you find it 

flies in circles.  

 Compass calibration does not need to be done every time you fly, or if you upgrade 

firmware without changing hardware position. However it should be done when 

components are moved or if the aircraft flies in unexpected ways. 

 

Compass calibration is carried out in three steps: horizontal calibration, vertical calibration and 

storage of magnetic compass data. Instructions for each stage can be found in the status bar 

at the top “Settings” interface, as follows: 

1. Switch the transmitter to manual mode 

and pull the throttle to minimum. 

 
Figure 35 

2. Click “Settings” to enter the settings 

interface, as shown in Figure 35. 

3. Click “Magnetic compass” to open the 

calibration dialog box, as shown in 

Figure 36. 

 
Figure 36 
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4. Select “Horizontal Alignment” and to click “OK” to start horizontal calibration. 

5. Hold the aircraft horizontally (within a 

status error of 5° which can be maintained if 

you hold the aircraft with both hands, as 

shown in Figure 37),turn around two or three 

times slowly making sure that the blue LED 

stays lit. If the blue LED goes off, stop and 

adjust the aircraft, before continuing. 

6. Now select “Vertical Alignment” and click 

“OK” for vertical calibration. 

 
Figure 37 

7. Hold the aircraft with the nose vertically 

down(within a status error of 5°, as shown 

in Figure 38) turn around two or three times 

slowly making sure that the blue LED stays 

lit. If the blue LED goes off, stop and adjust 

the aircraft, before continuing. 

8. Select “Save Alignment” in the dialogue box 

and click “OK”.  
Figure 38 

9. You will need to wait for the flight controller to process the recorded magnetic data. A 

purple LED will show during the processing. When the purple light goes out, calibration is 

complete. 

10. The ground station will switch to the remote control interface automatically and spend a 

few seconds calculating. Then it will display two circles, one blue and the other red, as 

indicated in the following figures: The superposition of two circles, red and blue indicates 

successful calibration. If this is not the case you need to start again with a new calibration 

operation. 

               

Calibration excellent           Calibration okay        Calibration unsuccessful 

Direction of 

aircraft nose 
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9.1.2 Compass Calibration Using a PC Ground Station 

NB 

 The magnetic compass must be calibrated before the first flight after installation of the 

X4V2 flight controller.  

 Calibration should be carried out in a clear space outside; calibration should not be done 

indoors or in an environment with strong magnetic fields, such as in the presence of cars 

or shipping containers.  

 You should also calibrate after re-arranging components in your aircraft or if you find it 

flies in circles.  

 Compass calibration does not need to be done every time you fly, or if you upgrade 

firmware without changing hardware position. However it should be done when 

components are moved or if the aircraft flies in unexpected ways.  

 

Compass calibration is carried out in three steps: horizontal calibration, vertical calibration and 

storage of magnetic compass data. Instructions for each stage can be found in the status bar 

at the top “Settings” interface, as follows: 

1. Switch the transmitter to manual mode and pull the throttle to minimum;  

2. Select “Settings(S)”→“Magnetic Compass (M)”for the “Magnetic Compass Alignment”

window as shown in Figure 39. 

3. Click “Horizontal Alignment” for horizontal calibration, as shown in Figure 40. 

 
Figure 39 

 
Figure 40 

4. Hold the aircraft horizontally (within a status error of 5° which can be maintained if you 

hold the aircraft with both hands, as shown in Figure 41),turn around two or three times 
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slowly making sure that the blue LED stays lit. If the blue LED goes off, stop and adjust 

the aircraft, before continuing. 

5. Now select “Vertical Alignment” and click “OK” for vertical calibration.  

6. Hold the aircraft with the nose vertically down(within a status error of 5°,as shown in 

Figure 42) turn around two or three times slowly making sure that the blue LED stays lit. If 

the blue LED goes off, stop and adjust the aircraft, before continuing. 

 
Figure 41 

 
  Figure 42 

7. Select “Save Alignment” in the dialogue box and click “OK”;  

8. You will need to wait for the flight controller to process the recorded magnetic data. A 

purple LED will show during the processing. When the purple light goes out, calibration is 

complete. 

9. The ground station will switch to the remote control interface automatically and spend a 

few seconds calculating. Then it will display two circles, one blue and the other red, as 

indicated in the following figures: The superposition of two circles, red and blue indicates 

successful calibration. If this is not the case you need to start again with a new calibration 

operation. 

               

Calibration Excellent          Calibration okay        Calibration unsuccessful 

9.2 Unlocking and Arming the Motors  

NB 

 The controller cannot be unlocked and motors armed near large airports, or within Beijing 

5th ring.  

Direction of 
aircraft nose 
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 The controller cannot be unlocked without GPS. 

 Magnetic compass calibration must be carried out before the first time you unlock the 

motors.  

 The flight controller will lock the motor again if no throttle has been applied within five 

seconds. In this instance you should perform the unlocking operation again.  

 Checking F/S protection is intended to reduce the possibility of accidents in the flight. 

Failsafe check should be made each time the system is powered. 

 The motor will run when applying throttle after unlocking. It’s normal for some motors to 

slow down or even stop if there has been no take off. The aircraft will take off normally 

only by increasing the throttle. 

 

Motors are locked by the X4V2 flight controller for the purpose of safety. Motors will run 

normally only after unlocking. The unlocking procedure, also known as arming or applying 

CSC, is as follows: using a FUTABA transmitter as an example (in Japanese stick mode, mode 

1).  

1. Check F/S protection by shutting off the transmitter, the flight status bar on the ground 

station should display “Returning and landing”, before attempting to unlock. If it does not 

you should reset failsafe.  

2. Unlock by pushing the rudder stick to the extreme left, and pull it fully down. Now push the 

aileron stick to the extreme right and pull it down.  

Note: 

When unlocking, the reverse V-type ( /\ )  is required for the left-hand pattern (Japanese and 

American, or Mode 1 and Mode 2) while the V-type  ( /\ ) is required for the right-hand pattern 

(Chinese and European, or Mode 3 and Mode 4).  

           

9.3 Inspecting Motor Rotational Direction 

You must inspect the direction of rotation of each motor before the aircraft takes off, in the 

same way that you would inspect the control surfaces of a fixed wing aircraft before takeoff.  
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Switch to manual mode and check F/S setting to allow unlocking;  

Using a four axis cross- type multirotor as an example; rotor direction inspection is carried out 

as follows. The diagrams that follow give the conditions required for other types of aircraft:  

1. Check motor balance by making sure that all four motors rotate at the same speed when 

gently applying throttle. 

2. Check the aileron channel. Push the aileron stick slightly to the left and the M4 motor 

should run immediately (Figure 43) while the other three motors remain static. Push the 

aileron stick slightly to the right and the M2 motor should rotate immediately (Figure 44) 

while the other three motors remain static.  

 
Figure 43 

 

Figure 44 

3. Inspect the climb and descent channel (Elevator) in the same way as the aileron channel. 

Push the elevator stick up and M3 should rotate (Figure 45). Pull the stick down to make 

M1 rotate (Figure 46).  

 
Figure 45 

 
Figure 46 

 

4-axis X-type:  

 

            Push aileron stick to left   Push aileron stick to right   Push elevator stick up   Push elevator stick up  
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6-axis cross type:  

 
Push aileron stick to left   Push aileron stick to right    Push elevator stick up    Push elevator stick up  

 

6-axis X- type:  

 

Push aileron stick to left   Push aileron stick to right   Push elevator stick up    Push elevator stick up 
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10 Flying at the Field   

10.1 Flight Status  

10.1.1 LED Status Indications 

 GPS  

The red light, blue light and green light indicate the current operational state of the aircraft 

as indicated the table below:  

Light colour Light status Operational status 

Red light (for all modes)  

3 flashes   •••  No GPS  

2 flashes   ••  GPS 5 satellites  

1 flash     • GPS 6 satellites  

Red light out  GPS 7 or more satellites  

Blue light (GPS mode, non-positioning)  
1 flash     • User in operation  

2 flashes   ••   Hovering at fixed height  

Green light (GPS mode, in positioning)  
1 flash     • User in operation  

2 flashes   •• Hovering at fixed point  

 

Note: 

 Only take off after 7 or more GPS satellites are in view.  

 The flight controller will use the take-off position as the home location when the GPS 

first locks in to seven satellites.  

 

 White LED  

(1) The LED white light indicates a large status error or a loose connection to the GPS 

module.  

(2) Action required when the white light comes on:  

– If the light comes on when the aircraft is suffering violent movement but goes out 

when it retains stability than you can continue the flight normally. 

– Land the aircraft as soon as possible if the white light shows continuously and 

check the GPS connection. Zero the gyro in the GCS if there is a status error. 

 Low voltage alarm 
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The red light will flash quickly as a low battery voltage alarm. It shows as a solid light in an 

emergency situation of extreme low voltage. 

 Barometer initialization failure 

A continuous red light showing when the aircraft is on the ground, indicates the failure of 

the barometer to initialize. You must restart the flight controller.  

 Magnetic field verification 

When calibrating, a continuous blue light indicates a magnetic compass calibration error 

less than 5° and indicates a successful calibration. However, if the blue light goes off with 

a status error more than 5° this indicates that adjustment is needed. The purple light will 

be on continuously when storing the data after calibration of the magnetic data. The 

purple light will go out completely when data storage is complete.  

10.1.2 Motor Balance and Real Throttle Position 

The two parameters of motor balance and real throttle position are shown as follows in the 

ground station:  

 Mobile ground station: open the mobile ground station and click “Data”, as shown in 

Figure 47. 

 PC ground station: Open Wi-Fi and the “Flight data” section will open at the bottom or 

select “View”→“Flight data” to check. The parameters are indicated in Figure 48. 

 
Figure 47 

 
Figure 48 

10.1.2.1 Motor Balance 

"Motor balance” will display an imbalance between the clockwise propellers or counter 

clockwise propellers when the aircraft is in a static hovering position. The propellers need to be 

balanced or replaced with higher quality units.  
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To ensure stable flight, accurate examination must be made of the balance and horizontal 

symmetry of the motors and propellers until the motor balance parameter displays “Good” 

when hovering the aircraft.  

10.1.2.2 Real Throttle Position 

The throttle position of the aircraft when hovering is usually at 40-65, which is considered 

normal (in green). Any position lower than 40 (shown in yellow) indicates the aircraft is 

maintaining a light load on the ESCs while higher than 65 (in red) indicates that the aircraft is 

heavy or the battery is delivering a low voltage. This situation requires a load adjustment or 

battery replacement.  

10.1.3 Adjusting Aircraft Vibration Parameters 

The following factors affect the flight stability of the aircraft and corresponding adjustment 

measures need to be carried out:  

1. Shaking, vibration or poor installation of the IMU will affect flight stability. Therefore 

attention should be paid to the following:  

– Make sure the host and slave controllers are in the correction direction (facing the 

aircraft nose) and firmly fixed in a position of as little resonance as possible on the 

aircraft. 

– The coefficients of shake and vibrate on the ground station indicate the amount of 

vibration of the IMU. Therefore, when installing the flight controller make sure the 

motors and propellers are installed in balance to reduce the shake and vibration state 

to lower than 10 (use smaller propellers to reduce the amount of vibration in the trial). 

An airframe structure of higher rigidity is recommended as a softer frame will cause 

additional vibration.  

 

Note:  

The Shake state and Vibrate state can be checked as follows:  

 Mobile ground station: open the mobile ground station and click “Data”, as shown 

in Figure 49. 

 PC ground station: Open Wi-Fi and the “Flight data” section will open at the 

bottom or select “View”→“Flight data” to check. The parameters are indicated in 

Figure 50. 
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Figure 49 

 
Figure 50 

 

2. The orientation of multiple axis aircraft is adjusted by adjusting speed of the motors. The 

sensitivity of the axis control will make a direct impact on the accuracy of the aircraft 

response.  Adjust the match between the aircraft weight and the screw pitch of the 

propeller to make sure the motor can generate an adequate rotation speed, producing 

enough control response. The lightest propeller possible, should be selected to reduce 

inertia and to improve command response. There should be a proper balance between 

flight efficiency and stability.  

3. The symmetry of multiple axis aircraft has a vital influence on flight stability.  

The symmetry of the motor and propeller can be evaluated in horizontal flight by referring 

to “10.1.2.1 Motor Balance”.  

4. Further improvements can be made to the stability of the aircraft by adjusting “Roll 

sensitivity”, “Pitch sensitivity” and “Sway Compensation” after completing the above three 

steps. 

 

Note:  

“Roll sensitivity”, “Pitch sensitivity” and “Sway Compensation” can be checked as follows: 

 Mobile ground station: open the mobile ground station and click “Parameter”, as 

shown in Figure 51. 

 On the PC ground station select “Settings” →“Parameters” to check, as shown in 

Figure 52. 
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Figure 51 

 
Figure 52 

10.2 Flight Functions  

10.2.1 Using Your Mobile Device for Remote Control of the Aircraft 

In automatic hovering 

status, click the menu key 

on the mobile ground 

station to select “Enable 

Control” to enter mobile 

remote control mode, as 

shown in the figures on the 

right: The button will 

change to “Disable 

Control”. 

    

Non-remote control mode    Remote control mode 

The transmitter sticks cannot be used in mobile remote control mode. Remote control 

using your mobile device is explained in the following table: 

After Enable Control Remote control interface operation Aircraft status 

Dot status Red: non-positioning Green: positioning - 

Hovering operation Do not touch any area of the screen Hovering 

Advance operation 

1. Touch the central circle and drag up or 

and down 

2. Touch the central circle and drag left or 

right 

3. Touch the central circle and drag 

1. move forwards or 

backwards 

2. move left or right 

3. move forward left, 

backward left, 
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After Enable Control Remote control interface operation Aircraft status 

diagonally forward right or 

backward right 

Climb / descend / 

rotate 

1. Touch the area above the circle (on the 

cross) 

2. Touch the area under the circle (on the 

cross) 

3. Touch the left side of the circle (on the 

cross) 

4. Touch the right side of the circle (on the 

cross) 

Note: 

 The distance between the click position 

and the center of a circle is equivalent 

to the change of speed of the aircraft, 

meaning the farther from the center, the 

higher speed of the aircraft. 

 The touch time is equivalent to the 

moving time of the aircraft. 

1. Climb 

2. Descend 

3. Rotate left 

4. Rotate right 

 

Note:  

Mobile remote control mode cannot be used without GPS positioning. (Indoors for example) 

10.2.2 Mobile Attitude Control Mode 

NB 

 Please keep the aircraft horizontal before starting attitude control mode. Otherwise, the 

aircraft will fly off in the direction that the mobile dips, after switching to this mode.  

 Mobile attitude control mode can only be used in mobile remote control mode.  

 Control mode will automatically switch immediately to mobile remote control mode after 

exiting from the mobile attitude control mode. However exiting mobile remote control 

mode will revert to transmitter control.  

 

Click the mobile device menu key and click “Enable Attitude Control” to open the attitude 

option, the remote control interface will switch to a blue cross, indicating that mobile attitude 
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control mode is started as shown the figures on the right. 

               
Non-attitude control mode               Attitude Control mode 

The status of attitude control mode can be seen in the following table:  

After Enable Control Remote control interface operation Aircraft status 

Dot status  Red: non-positioning Green: positioning  - 

Hovering operation  
Hold the mobile device horizontally and do 

not touch the screen 
Hovering  

Advanced operation 

1. Tilt the mobile device forwards and 

backwards  

2. Tilt the mobile device from left to right 

3. Tilt the mobile device from upper left to 

bottom left or upper right to bottom right  

1. Move forwards 

and backwards 

2. Move left and right  

3. Move forward left, 

backward left, 

forward right and 

backward right  

Climb / descend / 

rotate 

1. Click any area on the screen and drag 

upwards  

2. Click any area on the screen and drag 

downwards  

3. Click any area on the screen and drag to 

the left   

4. Click any area on the screen and drag to 

the right  

Note:  

 Dragging distance is proportional to the 

1. Climb  

2. Descend 

3. Rotate left 

4. Rotate right 
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After Enable Control Remote control interface operation Aircraft status 

speed of the aircraft, meaning that the 

longer the dragging distance, the higher 

the speed of the aircraft.  

 The time spent touching the screen is 

equivalent to the move duration of the 

aircraft.  

 

10.2.3 Semi-automatic Take Off 

The flight status will display “Auto hover” when seven or more satellites are in view and CH5 is 

in position 3 and CH6 in position 1. Now push the throttle after arming and the aircraft will take 

off after the throttle is in mid position and will hover automatically at a height of approximately 

2-3 metres.  

10.2.4 Return and Land 

NB 

For safety reasons it is not recommended to switch to return and land mode if the aircraft is 

too near to people. 

 

Return and land is achieved as follows:  

1. The aircraft will record automatically the starting position, after having attained GPS lock 

with seven or more satellites. 

2. Carry out any of the following operations to hand over control to the aircraft to return and 

land. The aircraft will not respond to the flight control sticks on the transmitter during this 

time: 

– Switch CH5 and CH6 to position 3 on the transmitter. 

– On the mobile ground station: click “Map”→“SPC”→“Auto Landing”;  

– On the PC ground station: select “View”→“Panel” and open the instrument panel and 

click “Auto landing”.  

3. The aircraft will land slowly after reaching the take-off point and at this stage you can 

adjust the position of the aircraft if you need to find a better landing position.  

The flight controller automatically applies throttle at this time and the throttle stick of the 

transmitter is inactive.  
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4. The motors will gradually stop rotation when the aircraft is fully on the ground and the 

throttle stick reduced to minimum. The motors will be locked after 5 seconds and a CSC 

operation is required before restarting.  

Note:  

 If the aircraft is 25m or more away from the return point and less than 20m in height, the 

aircraft will climb to 20m before returning when switched to auto land mode. The Aircraft will 

return to its original height after switching to auto land mode if the aircraft is higher than 

20m. The aircraft will return at its current height if the aircraft is less than 25m away from 

the return point.  

 The aircraft will exit from return and land mode only after switching CH5 to position 1.  

 

10.2.5 Fly to Point on the Map (FlyToPP) 

10.2.5.1 Mobile Ground Station Fly to Point 

NB 

Take care when using FlyToPP that the aircraft does not fly out of sight. 

 

FlyToPP can only be carried out in GPS automatic hover mode. The procedure is as follows:  

1. Switch CH5 to position 3 and CH6 to position 1 on the transmitter. 

2. Select a point on the map 

interface, a yellow smiley 

will appear at that point, 

as shown in Figure 53. 

3. Click "SWP” then “OK” 

the smiley will change 

into a purple star, as 

shown in Figure 54. 

4. Perform the same 

procedure to fly to the 

next target point.   
Figure 53 

 
Figure 54 

Note: 

The aircraft will fly without turning if the distance between two target points is less than 10m; 

the nose of the aircraft will turn towards the next target point if the distance is larger than 10m. 
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10.2.5.2 PC Ground Station Fly to Point (FlyToPP) 

Fly to point can only be achieved in GPS automatic hovering mode. The procedure is as 

follows:  

1. Switch CH5 to position 3 and CH6 to position 1 on the transmitter. 

2. Open the ground 

station and select 

“File”→“Open Wi-Fi”, 

a yellow smiley will 

display on the map, as 

shown in Figure 55: a 

purple star is beneath 

the yellow smiley. 
 

Figure 55 

3. Click a target point, the 

yellow round smiling 

face will move to the 

point and the covered 

purple star will be 

exposed, as shown in 

Figure 56. 

 
Figure 56 

4. Click “Fly to PP”, the 

purple star will move to 

the position of the yellow 

smiley, as shown in 

Figure 57. 

5. The aircraft will fly to this 

point and to the next 

target point if the same 

procedure is followed.  
 

Figure 57 

10.2.6 Way Point Flight 

10.2.6.1 Mobile Ground Station Waypoint Flight  

Waypoint flying is carried out as follows:  

1. Route design: Click “Map”→“Tool”→“Add Waypoints” then “OK” to open the route design 

interface; complete waypoint the design clicking each point on the route. 
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Route design can be made by adding single points consecutively (manual generation of 

route) or automatic route generation.  

 Editing single points: each waypoint contains the key parameters of “Height”, 

“Hovering time” and “Speed”. To edit waypoints, click on the waypoint and then select 

“Edit waypoint” from the pop-up window. 

– “Height”: means the altitude of the aircraft relative to the takeoff point at that 

waypoint. The aircraft will gain or lose altitude between waypoints if they are of 

different heights. The default altitude of a waypoint is the current height of the 

aircraft when switching to navigation mode. 

– “Hovering time”: is the 

time spent stationery at 

each waypoint. The default 

setting for the first waypoint 

is 65535.  

– “Speed”: is the speed of 

the aircraft to the next 

waypoint.  

Single point editing (manual generation of route) 

– “Photography setting”: sets up the ability to take a photograph at intervals or 

at each waypoint indicated along a route. The initial point, where the first 

photograph is taken should be set up according to the “Start photograph” routine 

described below. 

 Automatic generation of route: at least 4 

waypoints should be set up with the same 

height and flight speed at each waypoint. 

After setting up the waypoints, click “Tool”

→“Auto Make Waypoints” and edit the 

correct settings for“Delay”, “Interval”, 

“Altitude” and “Speed”. The software 

will now automatically generate a waypoint 

route. 

 

Automatic waypoint route generation  

2. Uploading a route: after drawing a route, it must be uploaded to the flight controller. Click 

“Upload Waypoints” in the Tools menu. The route can also be stored as a file for use in the 

future. Click “Save Waypoints” 

To examine whether each waypoint has been uploaded successfully, the color of the 

waypoint will change to blue indicating success or change to orange to indicate failure. 

Uploading should be done again in case of failure.  
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3. Route verification: Click “remove route points” to change blue points into orange points 

and click “verify waypoints”, to download the currently uploaded waypoints into the ground 

station for comparison. If all waypoints change to blue, the route stored in the flight 

controller is consistent with that in the ground station, indicating no errors. If this is not the 

case the route should be uploaded again. 

4. Waypoint flight  

 Automatic flight 

1) Switch CH5 to position 3 and CH6 to the position 2 on the transmitter. 

2) Click “Map”→“SPC”→“Enable Skyway”, the aircraft will fly automatically 

to the first waypoint and hover. 

3) Enter 2 in the text box “Target” in “Map”→“SPC”, and click “Target” 

now push the elevator stick up and the aircraft will fly to waypoints in the order 2, 

3, 4„ Until the route is complete when it will fly to the first waypoint and hover. 

 Semi-automatic flight  

1) Switch CH5 of the RC control TX to position 3 and CH6 to position 2.  

2) On the Android GCS select “Map ”→“SPC ”→“Enable Skyway ”→“Semi-Auto 

Skyway” and click “OK”, the aircraft will stay in its current position;  

3) Push the elevator stick on your TX and the aircraft will fly in the order 1, 2, 3, 

4…etc. until completion of all waypoints.  

Throttle and rudder can be used as normal during the flight.  

2. Exit: Switch CH5 to position 1 (in manual mode) or CH6 to position one (auto hover mode) 

to exit waypoint flying.  

Note: 

 If you have not set up a waypoint route the aircraft may fly away if you switch to auto 

navigation mode. After starting the motors, the flight status of the aircraft will change 

to automatic navigation 3 seconds after switching to automatic navigation mode.  

 The nose of the aircraft aligned to the next waypoint during waypoint route navigation. 

 If you want to control the direction of the nose, click “Map”→“SPC”→“Disable course 

locked” during waypoint flight. The aircraft will fly the route is normal but the nose will not 

point to the flight direction. It will be controlled by the rudder stick on the transmitter. Click 

“Enable course locked”, and the nose of the aircraft will point towards the flight direction 

again.  
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10.2.6.2 PC Ground Station Waypoint Flight  

Waypoint route flying is carried out as follows:  

1. Connect the PC via Wi-Fi and open the ground station. Select “File”→“Open Wi-Fi”;  

2. Route design: Click “ ” to open waypoint route design, click on each waypoint in turn, 

then click “ ” to exit waypoint generation. 

Waypoint route design can be single point editing (manual generation of route) and 

automatic route generation.  

 Single point editing: each waypoint contains key parameters of “Height”, “Cycle 

time” and “Speed”. Right click on the waypoint and select “Edit” to change these 

parameters. 

– “Height”: is the altitude of the aircraft relative to the takeoff point at that 

waypoint. The aircraft will gain or lose altitude between waypoints if they are of 

different heights. The default altitude of a waypoint is the current height of the 

aircraft when switching to navigation mode. 

– “Cycle time”: is the 

time spent stationery at 

each waypoint. The 

default setting for the 

first waypoint is 65535. 

– “Speed”: is the speed 

of the aircraft to the next 

waypoint. 
 

Single point edition (manual generation of route) 

– “Snapshot config”: sets up 

the ability to take a photograph 

at intervals or at each 

waypoint indicated along a 

route. The initial point, where 

the first photograph is taken 

should be set up according to 

the “Start photograph” routine 

described below.  

 
Route edition window 

Note: 

 Clicking the right button on a selected waypoint will give you the option of uploading 

editing or deleting. 

 Left click on the waypoint to display the waypoint properties. 
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 Automatic generation of route: at least 4 waypoints should be set up with the same 

height and flight speed at each waypoint.  

1) Select “Path Settings” “Edit Current Path” after setting up route points and the 

“Edit Waypoint” window will pop up. 

2) Click “Pattern Waypoints” and the “Pattern Waypoints” window will pop up.  

3) Select a waypoint and click LPT1 and enter a setting for “Pattern Delay”, “Pattern 

Interval” and “Pattern Speed”, then click “Make” and the software will 

automatically generate a flight route for the aircraft.  

 
1. Setting up waypoints 

 
2. Route edition window 

 
3. Setting of automatic generation of route 

parameters 

 
4. Automatic generation of route 

3. Uploading the route to the aircraft: right 

click a waypoint and click“Upload” or select 

“Path Settings”→“Upload Path to AP” 

after setting up the route. The route can also 

be stored as a file for use in the future. To 

examine whether each waypoint has been 

uploaded successfully, the waypoint color 

will change to blue indicating success, any 

other color would indicate failure, as shown 

in Figure 58. 

 
Figure 58 

4. Route verification: select “Path Settings”→“Download and Check Path”, to download 

the waypoints from the aircraft to the ground station for comparison. All route points will 

change into orange and then blue. All route points in blue indicate that the route stored in 
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the flight controller is consistent with that in the ground station, indicating no error in the 

route. If not, the route should be uploaded again. 

5. Waypoint flight 

 Automatic flight 

1) Switch CH5 to position 3 and CH6 to position 2.  

2) Click “Enable Skyway” 

on the right hand panel 

and a confirmation will 

pop up, as shown in 

Figure 59, click 

“Enable” and the 

aircraft will fly to the 

first waypoint and 

hover.  

 
Figure 59 

3) Enter 2 in the textbox “Target Waypoint” in the instrument panel and click 

“Change Target” Now push the elevator stick and the aircraft will fly between 

waypoints in the order 2, 3, 4…etc. until the route is complete when it will hover 

at the first waypoint. 

 Semi-automatic flight  

1) Switch CH5 of the RC control TX to position 3 and CH6 to position 2.  

2) On the Android GCS select “Map ”→“SPC ”→“Enable Skyway ”→

“Semi-Auto Skyway” and click “OK”, the aircraft will stay in its current 

position;  

3) Push the elevator stick on your TX and the aircraft will fly in the order 1, 2, 3, 

4…etc. until completion of all waypoints.  

Throttle and rudder can be used as normal during the flight.  

6. Exit: Switch CH5 to position 1 (in manual mode) or switch CH6 to position 1 (auto hover 

mode) to exit the function.  

Note: 

 If you have not set up a waypoint route the aircraft may fly away if you switch to auto 

navigation mode. After starting the motors, the flight status of the aircraft will change 

to automatic navigation 3 seconds after switching to automatic navigation mode.  

 The nose of the aircraft aligned to the next waypoint during waypoint route navigation. 

 If you want to control the direction of the nose, click “Map”→“SPC”→“Disable course 

locked” during waypoint flight. The aircraft will fly the route as normal but the nose will not 
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point to the flight direction. It will be controlled by the rudder stick on the transmitter. Click 

“Enable course locked”, and the nose of the aircraft will point towards the flight direction 

again.  

10.2.7 Tracking Mode (Heading Hold)  

This function can only be used in GPS mode and when seven or more satellites are in view. 

In tracking mode the aircraft flies along the waypoint route with the aircraft nose direction 

locked.  

Tracking mode is carried out as follows:  

1. Switch CH5 to position 3 (GPS hover mode) and move the transmitter sticks to as near 

neutral as possible. 

2. On the ground station, click “Enable Course Locked” on the instrument panel to start. 

3. Click “Disable Course Locked ” on the instrument panel to exit.  

 

10.2.8 Carefree Mode  

This mode must be used in GPS Hover Status. 

In carefree mode, the navigation direction of the aircraft is locked (i.e. the direction the aircraft 

is heading when entering this mode). Whatever direction faced by the nose of the aircraft, the 

flight direction will remain unchanged. The nose of the aircraft automatically keeps track of the 

gimbal so that the camera avoids the landing gear. The elevator and aileron of the aircraft take 

the navigation direction of the aircraft as reference.  

A schematic diagram of carefree mode is shown below:  

 

Enter carefree mode as follows: 

1. Switch to GPS mode after take-off, the aircraft will hover as normal.  

2. After selecting the desired flight direction align the nose of the aircraft in this direction. 

Switch CH5 from position 3 to position 2, switch back to position 3 then return to position 2. 
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You will now be in carefree mode.  

 

3. When you need to exit carefree mode, switch channel 5 to position 1 or position 3 (manual 

mode or GPS mode). 
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11 Tasks  

11.1 Servo Driven Gimbal 

The Y2 and Y1 ports on the flight controller 

are connected respectively to the gimbal 

pitch servo and the roll servo. You must 

power the servos separately from the flight 

controller when using a servo driven 

Gimbal. 

When using a servo driven gimbal the 

transmitter should have at least seven 

channels.  

Gimbal Battery

Y1/Y2 Port

Gimbal Servo

GND

VCC

Signal

 

 

 Gimbal pitch control: assign CH7 to a knob switch on the transmitter. Any adjustment of 

the knob will produce a corresponding tilt on the pitch servo. 

 Gimbal roll control: with no initial signal to the roll channel, the roll servo will remain in 

the neutral position to stabilize the roll axis of the gimbal. Adjust the roll channel according 

to the following procedure:  

a) Switch CH5 to position 1 and throttle back to minimum.  

b) Click “Settings” in the mobile ground station or the button “Init Setup” on the PC 

ground station. The knob currently assigned to CH7 is changed to control Gimbal roll.  

c) Click “Quit Setup” after adjusting the gimbal roll position, the new central position will 

be fixed and stored. CH7 will return to control Gimbal tilt.  

 

Note: 

 Octocopter does NOT support servo gimbal. 

 “PTZ Roll sensitivity” and “PTZ Pitch Sensitivity” on the parameter interface are used to 

adjust the gimbal correction angle. If the correction angle is too small that it should be 

increased and vice versa. A negative value should be entered to indicate reverse PTZ 

sensitivity. The range of PTZ sensitivity is -127 to 127. 

On the mobile ground station: click “Parameter”, as shown in Figure 60. 

On the PC ground station: select “Setting”→“Parameter Setting”, as shown in Figure 61. 
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Figure 60 

 
Figure 61 
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12 Safety Features 

12.1 Starting and Stopping the Motors  

12.1.1 To Start Motors 

The motors will be locked after 5 seconds if no throttle is applied before take-off, or after 

landing in manual mode with the pulled back to minimum. The motor will not rotate after it has 

been locked even if throttle is applied. Motors will rotate only after unlocking. Reference can be 

made to “9.2 Unlocking and Arming the Motors”.  

12.1.2 To Stop Motors 

The motors will stop when the throttle is pulled back to minimum in manual mode. In GPS 

mode, reducing the throttle to minimum will have the following differing results:  

– The aircraft will reduce altitude but the motors will not stop if the aircraft is in flight;  

– The motors will stop slowly until fully locked if the aircraft is on the ground.  

12.2 F/S Protection 

 Loss of Wi-Fi signal 

Full control of the aircraft will be handed to the transmitter if the loss of Wi-Fi signal 

exceeds 1 second when flying the aircraft with the Android mobile device. If the aircraft is 

waypoint flying, it will not be affected and will complete the route where it will hover 

awaiting further commands. 

 Loss of R/C transmitter signal 

F/S (failsafe) should be correctly set up. Refer to the RC transmitter manual to set CH5 in 

position 3, CH6 in position 3 and throttle in neutral for correct operation of failsafe. 

Failsafe will initialize when there is signal loss from the RC (receiver).  

– The aircraft will switch to auto hover for 5 seconds and then return and land if the 

signal is not recovered within five seconds.  

– The aircraft will keep flying for 5 seconds in automatic waypoint mode and will return 

and land if the signal is not recovered within 5 seconds.  
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12.3 Data Record 

12.3.1 Flight Data Record - “Black Box Function” 

The X4V2 flight controller has a flight data record function for fault analysis. It is not necessary 

to have any external memory or to initiate any application for this function to work. A record is 

made automatically during every flight. However, only the data of the last one minute before 

landing is recorded. Therefore if you need to examine this data, please do not make another 

flight or unlock the motors again.  

12.3.1.1 Obtaining Mobile Ground Station Data 

The flight data can be obtained from the mobile ground station as follows:  

1. Connect the power supply to the flight controller, open the mobile ground station and 

connect via Wi-Fi;  

2. Click “One minute data” in the “Setting” interface and a 

confirmation dialog box will pop up, as shown in Figure 

62.  

3. Click “OK” and the flight controller will upload to the 

mobile device the last minute of recorded flight data.  

4. It will take 1 minute to obtain the data and then report 

that completion of 1 minute data reading. 

5. The file “T-1min.hj” can be seen in the directory “YShj” in 

the root directory of the mobile device. You can make 

your own analysis of this data or email it to the 

manufacturer for debugging.  
 

Figure 62 

12.3.1.2 Obtaining PC Ground Station Data 

Flight data can be obtained from the PC ground station as follows:  

1. Connect the power supply to the flight 

controller and to the PC via Wi-Fi.  

2. Select “Settings”→“1 Minute Data” and a 

confirmation dialog box will pop up, as 

shown in Figure 63. 

3. Click “Yes” and the flight controller will 

blow to the PC the last minute of flight 

data.  

 
Figure 63 

4. After 1 minute to obtain the data, the instruction of completion of 1 minute data reading 

will pop up on the ground station;  
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5. The file “T-1min.hj” can be seen in the “Hj” directory of the PC ground station software 

package. You can make your own analysis of this data or email it to the manufacturer for 

debugging.  

12.3.2 GCS Data Record 

This function needn't any external device, just keeping the flight controller powering on and 

WIFI connecting, then all of the operation record will be saved by hj files in the related folder of 

GCS for analyzing. 

One hj file will be created once closing the GCS and all of data will be in one hj file if not 

closing GCS. 

 saved file path 

– mobile GCS: root folder in cellphone/YShj catalog 

– PC GCS: GCS/Hj catalog 

 document format: time.hj, for example, 20150506110410.hj, 20150506 means 

date,110410 means recording begin time from 11:04:10 
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13 Extending the Range of Capabilities 

13.1 Radio Connection 

The XB-PRO900 radio can be purchased as an option to extend the control distance, 

overcoming the distance limit of Wi-Fi for ground station and mobile device control.  

This radio has an RF power of 100mW on a frequency of 900MHZ and its measured two-way 

communication distance is 1-2 km in open ground. The radio has a RS232 port and the 

communication Baud rate is 115200bps.  

XB-PRO900 consists of two interchangeable radios, one on the aircraft and the other on the 

ground. 

13.1.1 Airborne Radio Connection 

Remove the Wi-Fi module from the aircraft and install the radio in the aircraft in the same way 

as the Wi-Fi module; connect to the COM port of the flight controller; the radio should be 

powered by a 3S-6S lithium battery.  

13.1.2 Ground Radio Connection 

Connect the Wi-Fi module to the other radio on 

the ground with the connection cable provided 

with the radio, which is powered separately. The 

unit on the ground consists of the radio and the 

Wi-Fi module.  

 

Note: 

The radio and Wi-Fi are powered with a 3S-6S lithium battery with the red/black cable, the red 

for anode (+) and the black for cathode (-).  

13.2 Connecting the Power Management Module 

Real-time current draw (Amps) and electricity consumption (mAh) can be observed in the 

“Data” interface of the ground station after connecting the optional Power Management 

Module to the X4V2 flight controller.  

To use this function connect the power management module (to the A1 port on the X4V2), 

reduce the throttle to minimum and then power the flight controller. The current (A) and 

electricity consumption (mAh) will be displayed, as shown in Figure 64. 
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13.3 OSD Connection  

After the OSD (On Screen Display) has been connected to 

the X4V2 flight controller, flight parameters will be overlapped 

in real time on the video display. This improves the quality of 

the flight experience because the pilot is constantly aware of 

vital flight parameters. Connect the OSD COM port to the 

COM port on the flight controller. Full details are available in 

the ZerOSD manual. 

 

 
Figure 64 
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14 Upgrading the Firmware  

NB 

Make sure the flight controllers not powered, if it is please disconnect. 

 

Before upgrading the firmware, please download the special firmware upgrade tool on the Zero 

UAV official website.  

http://www.zerouav.com/en/service/Download/Firmware/ 

Upgrading X4V2 firmware is simple! Upgrade the firmware according to the following 

procedure: 

1. Download the USB driver from the ZERO official website and install it. 

2. Plug the serial converter end of the USB cable into the PC USB port, the other end to the 

COM port on the Flight Controller, white cable upwards. 

3. Extract the “YS-X4-X4V2-X4P-Gemini-M-S” 

firmware upgrade archive and double-click 

“UpgradAP(En)-TOOL.exe” and the window 

“AP Firmware upgrade” will pop up, as 

shown in Figure 65. 

4. Click “Upgrade” and the window “AP 

Firmware upgrade” will pop up, as shown in 

Figure 66. 

 
Figure 65 

 
Figure 66 

5. Select the appropriate COM port for 

upgrading; (if you do not know which COM 

port on your PC is being used, right click “My 

computer”->“Properties”->”Device manager” 

->“port”(COM & LPT) to check, as shown in 

Figure 67) 

 
Figure 67 

http://www.zerouav.com/en/service/Download/Firmware/
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6. Click “Open Com”, if successful, the “Open” button will change from gray to black and 

become clickable;  

7. Click “Open” and to select the firmware file which will have a “.arm” extension from its 

stored location on your PC, as shown in Figure 68. 

8. Power up the flight controller and to wait for 

the automatic upgrade process to activate, 

as shown in Figure 69. 

9. Power-off the autopilot when it says in red, 

“Please Restart AP!” and then close the 

window, as shown in Figure 70.  
Figure 68 

 
Figure 69 

 
Figure 70 

 

Note: 

Please close the software and unplug the USB/serial port adapter if the upgrade operation fails. 

Restart the operation from the beginning.  
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Appendix  

Appendix 1 Introduction to Mobile Ground Station (Android) 

1. GCS Remote Control Interface  

     

 

The interface functions are introduced in the following table:  

No. Menu Item Function 

1 Remote control  Default setting: use the Green Cross to control flight 

2 Data  Real time flight data 

3 Map  Cached map or active real time map (Google Earth) 

4 Settings   Set up aircraft status 

5 Parameter  Adjust aircraft parameters  

6 Control interface  Multiple control modes using mobile device 

7 Central button  Directs the aircraft in simple control mode 

8 Quit Exit GCS software  

9 Set Define system settings 

10 Enable attitude control 

Click “Enable Attitude control” (red button) to start simple 
mobile device control mode. “Disable Attitude control” 
(green button)  
Click “Disable Attitude control” to exit. 

11 Enable control 
Click “Enable control” (red button) to start simple mobile 
device control mode. “Disable control” (green button)  
Click “Disable control” to exit.  
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Note:  

The aircraft serial number and firmware version will display on the remote control interface 

after data connection.  

 

2. Data Interface  

Click the “Data” tab for the data interface to see the screens shown below: the software will 

display communication disconnected in the center if there is no link with the aircraft.  

 

 

Descriptions of the parameters are as follows:  

Name Description 

Satellites  Shows number of GPS satellites in view and locked  

GPS velx(cm) 

GPS velx(cm) 
GPS velocity displays a value below 10 when static 

Xekf velx 

Xekf vely 

xekf veld 

Speed of the aircraft after Kalman filtering  

A value of 0-10 is displayed when the aircraft is static on the ground.  

Attitude angle Displays real-time attitude angle during flight 

Flight mode settings 

state  

Displays current craft status: Manual, Manual Altitude Hold, Auto Hover, Auto 

Navigation, Auto Go Home and Land; setup status. 

Altitude Barometer altitude of aircraft, units in metres 

Course angle  
Aircraft compass heading: Due North= 0°, clockwise direction is positive, 

counterclockwise direction is negative. For example: Due East=+ 90°, Due West=- 

90°, Due South=+ 180°. Does not apply in manual mode. 

AP voltage Power supply voltage 

GPS longitude  

GPS latitude  
GPS longitude and latitude  

Motor balance  Motor balance performance  

Vibration State Displays the influence of shake and vibration on the IMU from different 
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Name Description 

Shake State 

 

directions: a parameter under 10 indicates normal, larger than 10 indicates 

that shake and vibration exceeds the limit, requiring adjustment to the 

airframe to reduce vibration.  

Distance from home  The distance of the aircraft from the starting point 

Flight time  Flight time of the aircraft  

Real throttle   Actual position of throttle  

 

 

3. Map Interface 

A map must be downloaded from 

the Internet before the initial 

opening of the “Map” interface. 

The map will return to its last 

closing position, when reopening 

the map.  

The map interface is shown on 

the right side. 

Map parameters are shown in the 

following table: 

 

 

Name Description 

Snaps Manual photography 

 

Show the number of photos. 

The maximum number of pictures recorded is 250. The ground station will 

restart the count if this number is exceeded. 

Locate My location, Plane location and Search location.  

SWP  Fly to Point (FlyToPP)  

SPC  Waypoint and Route flying 

Tool  Map tools related to the defined waypoint route  

 

 

4. Waypoint Editing 

The waypoint editing interface are as shown in Figure 71 and Figure 72. 
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Figure 71 

 
Figure 72 

 
Figure 73 

 

Waypoint editing parameters are shown below:  

Name Description 

Single point edit  Edit longitude, latitude, height and speed between waypoints 

Single point upload  Upload waypoint 

Single point cancel Cancel waypoint 

No.  Number of waypoints 

Height Waypoint altitude in meters 

Longitude  Longitude of single waypoint 

Latitude  Latitude of single way point  

Hovering time  Time spent at each waypoint. Zero means no delay at waypoint.  

Photograph setting   Setup photographic task at waypoint 

Target speed  Flight speed between waypoints 

 

5. Settings Interface 

Please take care with these settings as they are vitally important.  

The settings interface is as shown in Figure 73. The parameters are shown below. 

Parameter name Parameter description 

Capture Transmitter 

Centre point 

With no wind, in manual mode, after flying and trimming, activating this 

will define the neutral point.  

NB: Make sure your TX throttle stick is in the middle position; it does not 

affect the actual throttle position. 

Adjust transmitter Used to calibrate the transmitter’s joystick 
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Parameter name Parameter description 

Magnetic compass  
Click to enter "Magnetic Compass" Calibration mode, the status bar above 

displays the calibration status. 

1 Minute Data  
Used to initiate reading the data saved in the FC within the last minute of 

flight. Please refer to “12.3.1Flight Data Record - “Black Box Function””. 

Installation guide 
The "Installation Guide" will guide you through installation and alignment 

step by step 

Init Setup 

Used to align channels or enter parameters of craft. Flight status will 

display "Settings" after clicking this button. Once in settings, the control 

channels for each motor on the craft are directly connected to the throttle 

channel of the TX and there is no mix output. 

Quit setup 
After completing Throttle Alignment and when all parameters have been 

entered, you may click this button to exit from settings. 

Zero Gyro Zero the gyro. The aircraft should be perfectly level when you do this. 

Snapshot Trigger camera shutter manually 

Mixing Define Defines custom mixing of throttle, roll, pitch and yaw. 

Follow Me  
If the Android Ground Station has GPS enabled, the aircraft will follow the 

moving course of the Ground Station. 

Test Open Parachute  
Test parachute open before flight, hold down the container lid to prevent 

deployment.  

Test Close Parachute  Close parachute after testing. 

 

Appendix 2 Introduction to PC Ground Station  

1. Main Interface  

 

 

2. Menu Bar Profile 
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 File(F) Tab 

 

 View (V) Tab  

 

 

 Path Settings (S) Tab 

 

 Tools (T) Tab 

 

 

 Settings (S) Tab 

 

 Help(H) Tab: software version 

 
 

 

Note: 

 The correct COM port must be selected when connecting to the flight controller with the 

USB/serial port adaptor cable.  

 When the map is flat mode, you can download offline maps. 

 

The view tab includes the following sections: 

 Toolbar  
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View Mode Design Route Flag Waypoint Move Route GCS Version

Measure Distance Edit Route Toggle Mode View from Top

 

 

 Flight Data (F) 

 

 

 

 Dashboard 

 

 

Appendix 3 Installation and Configuration Videos  

 Setting up the Futaba T8FG transmitter radio:  

http://www.tudou.com/programs/view/e1ai526Mbt4/ 

 Wi-Fi configuration:  

http://v.youku.com/v_show/id_XNTE2OTY4MjQ4.html/ 

 Upgrading firmware:  

http://v.youku.com/v_show/id_XNTE3NzEzOTky.html/ 

 

Appendix 4 Technical Support  

Please contact ZERO UAV for technical support for any problems arising from actual operation. 

Relevant technical documents can be downloaded in the download section in the official 

http://www.tudou.com/programs/view/e1ai526Mbt4/
http://v.youku.com/v_show/id_XNTE2OTY4MjQ4.html/
http://v.youku.com/v_show/id_XNTE3NzEzOTky.html/
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website of ZERO UAV.  

 ZERO UAV official website: www.zerouav.com 

 ZERO UAV Tel: +8610-82825271 

 ZERO UAV QQ Group: 168451730(Group1), 228669705(Group2), 242018689(Group3), 

53371874(Group4) 

 

Appendix 5 Reference Manual Update History  

No. Version Modification Modifier Date 

1 V1.0 To prepare first version  Technical support 1 2014.9.1 

2 V1.0 English revision Chris Hornby 2014.12.25 

3 V1.1 

1. Format Adjustments 

2. added functions: 

  10.2.1.6 Way Point Flight: 

Semi-automatic flight 

Technical support 1 2015.1.23 

1. Format Adjustments 

2. Modify parameters, diagram 
Technical support 1 2015.5.4 

Added function: GCS Data Record Technical support 1 2015.5.14 

 

http://www.zerouav.com/
mailto:chris@zenmail.com
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